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Element Description

The Related URLs element provides access to resources related to a collection. The Related URL may also link to data access points, as well as 
relevant tools and services. 

Note: This wiki page pertains to Related URLs in collection level metadata. For guidance on Related URLs in granule level metadata, please see the R
.elatedURLs (GRANULES) wiki page

Best Practices

The Related URLs metadata element allows for the linkage of a metadata record to external resources or locations on the web. When used properly, 
this element allows users to quickly and easily access data, as well as access relevant services and information about the data. Related URLs at the 
collection level should point to:

A data access location
A landing page for the associated dataset
Any relevant services provided for the data (if applicable) such as: Web Map Services (WMS), OPeNDAP, THREDDS, Web Map Tile 
Services (WMTS), Web Coverage Services (WCS), etc.
A user's guide and/or comparable documentation which provides important information about how to use the data 
The project home page
Relevant software packages
Relevant online data tools
Relevant PI documentation
Read-Me files
Data citation policies
Algorithm Theoretical Basis Document (ATBD)
OpenSearch Description Document (OSDD) links
Any other documentation directly related to the dataset (examples include: data recipes, micro articles, product quality assessment 
documentation, important announcements, documentation on dataset anomalies, etc.)  

There are two special sub-sections within Related URLs. These include the   and the   sub-elements. GET DATA USE SERVICE API A separate wiki 
page with full details has been developed for each of these sub-sections:

Related URLs (GET DATA)

Related URLs (USE SERVICE API)

The details on this wiki page are for general Related URL guidance and do not include any of the GET DATA or USE SERVICE API sub-elements. 

Several of the elements within the Related URLs section of the metadata serve to properly identify the purpose of the link. These identifying elements 
include:

URL Content Type: The URL Content Type is a keyword which, at a high level, describes the content of a link. This is a controlled vocabulary 
field maintained as an enumeration list within the UMM-Common schema with the following options: "CollectionURL", "PublicationURL", 
"DataCenterURL", "DistributionURL", "DataContactURL", "VisualizationURL". The URL Content Type helps specify how the URL will be 
displayed in the Earthdata Search Client.   

URL Type: The URL Type is a keyword which specifies the content of a link. URL Type keywords are maintained in the Keyword Management 
System (KMS). A list of valid URL Type keywords can be found here:  https://gcmd.earthdata.nasa.gov/kms/concepts/concept_scheme
/rucontenttype?format=csv

Note that the keyword list does not include the upper level URL Content Type keywords (specified above & maintained in the UMM schema). 
Please see the diagram below for details on the relationship between URL Content Type keywords and URL Type keywords.  

URL Subtype: The URL Subtype is a keyword which further specifies the content of a link. Together, the URL Type and Subtype keywords 
create a keyword hierarchy which is used to identify the URL. Providing a Subtype is optional, but should be used when applicable. The URL 
Subtype keywords are maintained in the  . A list of valid URL Subtype keywords can be found here: Keyword Management System (KMS) https://
gcmd.earthdata.nasa.gov/kms/concepts/concept_scheme/rucontenttype?format=csv

https://wiki.earthdata.nasa.gov/pages/viewpage.action?pageId=138875957
https://wiki.earthdata.nasa.gov/pages/viewpage.action?pageId=138875957
https://wiki.earthdata.nasa.gov/pages/viewpage.action?pageId=112497279
https://wiki.earthdata.nasa.gov/pages/viewpage.action?pageId=115935272
https://git.earthdata.nasa.gov/projects/EMFD/repos/unified-metadata-model/browse/collection/v1.10/umm-cmn-json-schema.json#1543
https://wiki.earthdata.nasa.gov/display/ED/KMS+User%27s+Guide
https://wiki.earthdata.nasa.gov/display/ED/KMS+User%27s+Guide
https://gcmd.earthdata.nasa.gov/kms/concepts/concept_scheme/rucontenttype?format=csv
https://gcmd.earthdata.nasa.gov/kms/concepts/concept_scheme/rucontenttype?format=csv
https://wiki.earthdata.nasa.gov/display/ED/KMS+User%27s+Guide
https://gcmd.earthdata.nasa.gov/kms/concepts/concept_scheme/rucontenttype?format=csv
https://gcmd.earthdata.nasa.gov/kms/concepts/concept_scheme/rucontenttype?format=csv


Description: While not required, it is highly recommended that a description be provided for each URL provided in the metadata. The 
description should be kept brief and explain where the link navigates and the type of information it contains. Descriptions should be unique to 
the link. While descriptions can be repeated for the same type of URL across different metadata records, it is generally advised that the same 
description not be repeated within the same metadata record. i.e. the description should be used to further differentiate two URLs with the same 
URL Type and Subtype. 

Examples:

URL: https://daac.ornl.gov/ACTAMERICA/guides/ACTAMERICA-PICARRO_Ground.html

URL Content Type: PublicationURL 

URL Type: VIEW RELATED INFORMATION

URL Subtype: USER'S GUIDE

Description: The guide document contains detailed information about the dataset.

URL: https://ghrc.nsstc.nasa.gov/home/micro-articles/lake-effect-snow

URL Content Type: PublicationURL

URL Type: VIEW RELATED INFORMATION

URL Subtype: MICRO ARTICLE

Description: Learn about how AMSR-2 data can be used to study lake effect snow in this micro article. 

Please see the below diagram for the full relationship between URL Content Type, Type, and Subtype keywords:

   

Element Specification

Related URLs is a required metadata element. At least 1 Related URL must be provided. Multiple URLs may be provided if necessary 
(Cardinality: 0..*).

Model Element Type Usable Valid 
Values

Constraints Required? Cardinality Notes

UMM-
Common

RelatedUrls
/URL

String n/a 1 - 1024 
characters

Yes 1

UMM-
Common

RelatedUrls
/Description

String n/a 1 - 4000 
characters

No 0..1 It is strongly recommended that a description be provided for 
each URL.

https://daac.ornl.gov/ACTAMERICA/guides/ACTAMERICA-PICARRO_Ground.html
https://ghrc.nsstc.nasa.gov/home/micro-articles/lake-effect-snow


UMM-
Common

RelatedUrls
/URLContentT
ype

Enumer
ation

CollectionURL

PublicationURL

DataCenterURL

DistributionURL

DataContactURL

VisualizationURL

n/a Yes 1 The DataCenterURL option is only valid in the Data Centers 
section of the metadata. The DataContactURL option is only valid 
in the Data Contacts section of the metadata.

UMM-
Common

RelatedUrls
/Type

String GCMD URL Content 
Type 'Type' Keywords

KMS controlled Yes 1 Each Type keyword corresponds to a specific URL Content Type 
category.

UMM-
Common

RelatedUrls
/Subtype

String GCMD URL Content 
Type 'Subtype' 
Keywords

KMS controlled No 0..1 The Type and Subtype are part of a keyword hierarchy specified 
in the .KMS

Metadata Validation and QA/QC

All metadata entering the CMR goes through the below process to ensure metadata quality requirements are met. All records undergo CMR validation 
before entering the system. The process of QA/QC is slightly different for NASA and non-NASA data providers. Non-NASA providers include 
interagency and international data providers and are referred to as the International Directory Network (IDN).

Please see the expandable sections below for flowchart details.

Manual Review
Identify errors, discrepancies or omissions.
Confirm that the URLs link to the appropriate web pages.

Automated Review
Check that the field has been populated.
Check that the e field is populated with a valid value from KMS.URL_Content_Typ
Check for potential broken links.
Check that the URL is formatted correctly.
Check that the field length of Description is not greater than 12,000 characters.
Check that the field length of URL is not greater than 1,024 characters.

Checks to see that the URL value is a syntactically valid URL.
Checks to see if a description is present.
Validates that the RelatedUrl/Type and Subtype values correspond to the correct value in the URLContentType element.
Validates that the object types of GET DATA and GET SERVICE are only used with Distribution URLs.

ARC Priority Matrix

Priority 
Categorization

Justification

https://gcmd.earthdata.nasa.gov/kms/concepts/concept_scheme/rucontenttype?format=csv
https://gcmd.earthdata.nasa.gov/kms/concepts/concept_scheme/rucontenttype?format=csv
https://gcmd.earthdata.nasa.gov/kms/concepts/concept_scheme/rucontenttype?format=csv
https://gcmd.earthdata.nasa.gov/kms/concepts/concept_scheme/rucontenttype?format=csv
https://gcmd.earthdata.nasa.gov/kms/concepts/concept_scheme/rucontenttype?format=csv
https://gcmd.earthdata.nasa.gov/kms/concepts/concept_scheme/rucontenttype?format=csv
https://wiki.earthdata.nasa.gov/display/CMR/ARC+Priority+Matrix


Red = High 
Priority Finding

This element is categorized as highest priority when:

No Related URLs are provided.
No data access URL is provided. For further details on data access URLs please see the Related URLs (GET DATA) 

.wiki page
There is a service available for a collection, but no service URL is provided. For further details on service URLs 
please see the .Related URLs (USE SERVICE API) wiki page
No  is provided and no link to the data set landing page is provided.DOI
No User's Guide link is provided, but one is available.

The URL provided is broken.
The URL provided is incorrect/unrelated to the associated dataset.
The URL Type or Subtype provided does not accurately describe the link (i.e. the link is mislabeled).
The URL Type or Subtype provided does not align with the .KMS

The Type or Subtype does not exist in the .KMS
The Type or Subtype is placed in the incorrect position of the hierarchy (e.g. GET DATA should not be provided in 
the Subtype field, because it is categorized as a Type keyword in the ).KMS
There is an invalid Type/Subtype relationship (e.g. Type: GET DATA, Subtype: USER'S GUIDE, is not a valid 
combination in the ).KMS

The URL links to an FTP server (this only applies to NASA EOSDIS metadata).

Yellow = Medium 
Priority Finding

This element is categorized as medium priority when:

A URL is provided but the 'Description' element is left blank. It is highly recommended that a description be provided for 
each URL.
If a recommendation is made to add a new URL to the metadata, there will be accompanying yellow recommendations to 
add the appropriate URLContentType/URLType/Subtype/Description elements.

Note: These recommendations are blue at the  since the schema does not require Related URLs at the granule level
granule level. 

A recommendation is made to change a valid URL Type or Subtype keyword for purposes of consistency with other similar 
metadata records.
A  is provided but no link to the data set landing page is provided. When viewing the raw metadata file, the DOI is not DOI
formatted as a hyperlink. Providing a link to the data set landing page (preferably via DOI URL) provides quick access to 
the data set landing page directly from the raw metadata file. 

Blue = Low 
Priority Finding

This element is categorized as low priority when:

The  is identical for multiple URLs. It is recommended that a unique description be provided for each 'Description' element
link. 
A URL is provided via "http" when "https" is available.
The URL provided in the metadata re-directs. It is recommended that the most current link always be provided.

A noted exception to this is DOI URLs (e.g. ) since these will always re-https://doi.org/10.3334/ORNLDAAC/1416
direct.

If a URL with Type "USE SERVICE API" is present, but no mime type is provided, a blue recommendation will be made to 
add a mime type for the service URL. 
If a recommendation is made to add a new "USE SERVICE API" URL to the metadata, there will be an accompanying 
blue recommendation to add a mime type for the service URL. 
A recommendation is made to remove duplicate URLs.

Green = No 
Findings/Issues

The element is provided and follows all applicable criteria specified in the best practices section above.

ARC Automated Checks

ARC uses the  for automated metadata checks. Please see the  for more information. pyQuARC library pyQuARC GitHub

Dialect Mappings
 DIF 9 (Note: DIF-9 is being phased out and will no longer be supported after 2018)

DIF 10

Related_URL is a required metadata element. At least 1 Related_URL must be provided. Multiple URLs may be provided if necessary 
(Cardinality: 0..*).

UMM-C Element DIF 10 Path Type Usable Valid 
Values

Constraints Required 
in DIF 
10?

Cardinality Notes

RelatedUrls/URL Related_URL/URL URL No 0..* The link is provided here.

RelatedUrls
/URLContentType

The URLContentType is derived from 
the Types.

RelatedUrls/Type Related_URL
/URL_Content_Type
/Type

String GCMD URL Content 
Type 'Type' Keywords

KMS controlled No 0..1

https://wiki.earthdata.nasa.gov/pages/viewpage.action?pageId=112497279
https://wiki.earthdata.nasa.gov/pages/viewpage.action?pageId=112497279
https://wiki.earthdata.nasa.gov/pages/viewpage.action?pageId=115935272
https://wiki.earthdata.nasa.gov/display/CMR/DOI
https://gcmd.earthdata.nasa.gov/kms/concepts/concept_scheme/rucontenttype?format=csv
https://gcmd.earthdata.nasa.gov/kms/concepts/concept_scheme/rucontenttype?format=csv
https://gcmd.earthdata.nasa.gov/kms/concepts/concept_scheme/rucontenttype?format=csv
https://gcmd.earthdata.nasa.gov/kms/concepts/concept_scheme/rucontenttype?format=csv
https://wiki.earthdata.nasa.gov/pages/viewpage.action?pageId=138875957
https://wiki.earthdata.nasa.gov/display/CMR/DOI
https://doi.org/10.3334/ORNLDAAC/1416
https://github.com/NASA-IMPACT/pyQuARC
https://github.com/NASA-IMPACT/pyQuARC
https://git.earthdata.nasa.gov/projects/EMFD/repos/unified-metadata-model/browse/collection/v1.9/DIF-UMM-ECHO_Mapping.xlsx
https://gcmd.earthdata.nasa.gov/kms/concepts/concept_scheme/rucontenttype?format=csv
https://gcmd.earthdata.nasa.gov/kms/concepts/concept_scheme/rucontenttype?format=csv


RelatedUrls/Subtype Related_URL
/URL_Content_Type
/Subtype

String GCMD URL Content 
Type 'Subtype' 
Keywords KMS controlled

No 0..1 The Type and Subtype are part of a 
keyword hierarchy specified in the  .KMS

If none of the available Subtypes are 
appropriate for the URL, then it is okay 
to leave the Subtype field blank.

RelatedUrls/Description Related_URL
/Description

String No 0..1 It is strongly recommended that a 
description be provided for each URL.

RelatedUrls/GetData
/MimeType

Related_URL
/Mime_Type

String GCMD Mime Type 
Keywords

KMS controlled No 0..1 This is only translated to UMM if the 
The

RelatedUrls/GetService
/Protocol

Related_URL/Protocol String No 0..1

Related_URL/Title String No 0..1

Multimedia_Sample
/File

String No 0..1

RelatedUrls/URL Multimedia_Sample
/URL

String No 0..1

Multimedia_Sample
/Format

String No 0..1

Multimedia_Sample
/Caption

String No 0..1

RelatedUrls/Description Multimedia_Sample
/Description

String No 0..1

RelatedUrls/URLContentTyp
e = VisualizationURL

For all Multimedia URLs translated to 
UMM the URLContentType is 
VisualizationURL

RelatedUrls/Type = GET 
RELATED VISUALIZATION

For all Multimedia URLs translated to 
the Type is UMM GET RELATED 

VISUALIZATION

Example Mapping

DIF 10

<Multimedia_Sample>

  <File>ACOS</File>

  <URL>https://docserver.gesdisc.eosdis.nasa.gov/public
</URL>/project/OCO/ACOS.Lite.2015_v7.3.png

  <Format>PNG</Format>

  <Caption>Global amounts of column CO2, averaged for 
2015, using ACOS_L2_Lite_FP v7.3.</Caption>

  <Description>Global amounts of column CO2, averaged 
for 2015, using ACOS_L2_Lite_FP v7.3. This average 
used 365 "Lite" files, gridded on a 6x6 deg grid, and 
smoothed for the presentation.</Description>

</Multimedia_Sample>

...

<Related_URL>
  <URL_Content_Type>
    <Type>dataset LANDING PAGE</Type>
  </URL_Content_Type>
  <URL> </URL>https://doi.org/10.3334/ORNLDAAC/1568

  <Description>Access the dataset landing page for the 
collection.</Description>
</Related_URL>

<Related_URL>
  <URL_Content_Type>
    <Type>VIEW RELATED INFORMATION</Type>
    <Subtype>USER'S GUIDE</Subtype>
  </URL_Content_Type>
  <URL>https://daac.ornl.gov/ACTAMERICA/guides

</URL>/ACTAMERICA-PICARRO_Ground.html

  <Description>The guide document contains detailed 
information about the dataset.</Description>
</Related_URL>

UMM

https://gcmd.earthdata.nasa.gov/kms/concepts/concept_scheme/rucontenttype?format=csv
https://gcmd.earthdata.nasa.gov/kms/concepts/concept_scheme/rucontenttype?format=csv
https://gcmd.earthdata.nasa.gov/kms/concepts/concept_scheme/rucontenttype?format=csv
https://gcmd.earthdata.nasa.gov/kms/concepts/concept_scheme/rucontenttype?format=csv
https://gcmd.earthdata.nasa.gov/kms/concepts/concept_scheme/MimeType?format=csv
https://gcmd.earthdata.nasa.gov/kms/concepts/concept_scheme/MimeType?format=csv


"RelatedUrls": [
  {
    "Description": "Global amounts of column CO2, 
averaged for 2015, using ACOS_L2_Lite_FP v7.3. This 
average used 365 \"Lite\" files, gridded on a 6x6 
deg grid, and smoothed for the presentation.",
    "URLContentType": "VisualizationURL",
    "Type": "GET RELATED VISUALIZATION",
    "URL": "https://docserver.gesdisc.eosdis.nasa.gov
/public/project/OCO/ACOS.Lite.2015_v7.3.png"
  }, {
    "Description": "Access the dataset landing page 
for the collection.",
    "URLContentType": "CollectionURL",
    "Type": "dataset LANDING PAGE",
    "URL":  "https://doi.org/10.3334/ORNLDAAC/1568",
  }, {
    "Description": "The guide document contains 
detailed information about the dataset.",
    "URLContentType": "PublicationURL",
    "Type": "VIEW RELATED INFORMATION",
    "Subtype": "USER'S GUIDE",
    "URL":  "https://daac.ornl.gov/ACTAMERICA/guides
/ACTAMERICA-PICARRO_Ground.html"
  }
]

ECHO 10

An unlimited amount of OnlineResources and/or AssociatedBrowseImageUrls may be listed (Cardinality: 0..*)

UMM-C 
Element

ECHO 10 Path Type Usable 
Valid 
Values

Constraints Required 
in 
ECHO10?

Cardinality Notes

RelatedUrls/URL /OnlineAccessURLs
/OnlineAccessURL/URL

String String length 
from 1 to 1024

Yes 1

RelatedUrls
/Description

/OnlineAccessURLs
/OnlineAccessURL
/URLDescription

String String length 
from 1 to 4000

No 0..1

RelatedUrls/URLC
ontentType = 
DistributionURL

All OnlineAccessURLs are URLContentTypes of 
DistributionURL

RelatedUrls/Type 
= GET DATA

All OnlineAccessURLs are Types of GET DATA

RelatedUrls
/GetData
/MimeType

/OnlineAccessURLs
/OnlineAccessURL
/MimeType

String String length 
from 1 to 50

No 0..1

RelatedUrls/URL /Collection
/OnlineResources
/OnlineResource/URL

String String length 
from 1 to 1024

Yes 1

RelatedUrls
/Description

/Collection
/OnlineResources
/OnlineResource
/Description

String String length 
from 1 to 4000

No 0..1

RelatedUrls
/URLContentType

RelatedUrls/Type

RelatedUrls
/Subtype

/Collection
/OnlineResources
/OnlineResource/Type

String Any GCMD 
URL Content 
Type 
Keyword

KMS controlled

String length 
from 1 to 50

Yes 1 ECHO 10 only has a single URL Type field (not a Type 
and Subtype field). Thus, a URL Type may be selected 
from either the  or  keywords.URL Type Subtype

RelatedUrls
/GetData
/MimeType

/Collection
/OnlineResources
/OnlineResource
/MimeType

String GCMD Mime 
Type 
Keywords

KMS controlled

String length 
from 1 to 50

No 0..1 It is recommended that a mime type always be 
provided for service URLs.

RelatedUrls/URL /Collection
/AssociatedBrowseImage
Urls/ProviderBrowseUrl
/URL

String String length 
from 1 to 1024

No 0..1 This element can be used to link to a browse image. 
Browse images may also be provided as an Online 
Resource URL. Use of the Associated Browse URL 
element is discouraged in favor of the Online Resource 
URL.

https://gcmd.earthdata.nasa.gov/kms/concepts/concept_scheme/rucontenttype?format=csv
https://gcmd.earthdata.nasa.gov/kms/concepts/concept_scheme/rucontenttype?format=csv
https://gcmd.earthdata.nasa.gov/kms/concepts/concept_scheme/rucontenttype?format=csv
https://gcmd.earthdata.nasa.gov/kms/concepts/concept_scheme/rucontenttype?format=csv
https://gcmd.earthdata.nasa.gov/kms/concepts/concept_scheme/rucontenttype?format=csv
https://gcmd.earthdata.nasa.gov/kms/concepts/concept_scheme/rucontenttype?format=csv
https://gcmd.earthdata.nasa.gov/kms/concepts/concept_scheme/MimeType?format=csv
https://gcmd.earthdata.nasa.gov/kms/concepts/concept_scheme/MimeType?format=csv
https://gcmd.earthdata.nasa.gov/kms/concepts/concept_scheme/MimeType?format=csv


RelatedUrls
/Description

/Collection
/AssociatedBrowseImage
Urls/ProviderBrowseUrl
/Description

String String length 
from 1 to 4000

No 0..1 A brief explanation/ description of the browse image.

/Collection
/AssociatedBrowseImage
Urls/ProviderBrowseUrl
/FileSize

Long No 0..1

/Collection
/AssociatedBrowseImage
Urls/ProviderBrowseUrl
/MimeType

String String length 
from 1 to 50

No 0..1

RelatedUrls/URLC
ontentType = 
VisualizationURL

For all AssociatedBrowseImageUrls translated to UMM 
the URLContentType is VisualizationURL

RelatedUrls/Type 
= GET RELATED 
VISUALIZATION

For all  translated to UMM AssociatedBrowseImageUrls t
he Type is GET RELATED VISUALIZATION

Example Mapping

ECHO 10

<OnlineAccessURLs>
  <OnlineAccessURL>
    <URL>https://daac.ornl.gov/daacdata/actamerica
/ACTAMERICA-PICARRO_Ground/</URL>
    <URLDescription>This link allows direct data 
access via Earthdata login</URLDescription>
  </OnlineAccessURL>
</OnlineAccessURLs>
<OnlineResources>
  <OnlineResource>
    <URL>https://doi.org/10.3334/ORNLDAAC/1568</URL>
    <Description>Access the dataset landing page for 
the collection.</Description>
    <Type>dataset LANDING PAGE</Type>
  </OnlineResource>
  <OnlineResource>
    <URL>https://daac.ornl.gov/ACTAMERICA/guides
/ACTAMERICA-PICARRO_Ground.html</URL>
    <Description>The guide document contains 
detailed information about the dataset.</Description>
    <Type>USER'S GUIDE</Type>
  </OnlineResource>
  <OnlineResource>
    <URL>https://daac.ornl.gov/graphics/browse
/project/act-america_logo.png</URL>
    <Description>Browse Image</Description>
    <Type>GET RELATED VISUALIZATION</Type>
    <MimeType>image/png</MimeType>
  </OnlineResource>
</OnlineResources>
...
<AssociatedBrowseImageUrls>
  <ProviderBrowseUrl>
    <URL>https://s3.amazonaws.com/grfn-static
/SENTINEL-
1_INSAR_UNWRAPPED_INTERFEROGRAM_AND_COHERENCE_MAP_bro
wse.png</URL>
  </ProviderBrowseUrl>
</AssociatedBrowseImageUrls>

UMM



"RelatedUrls": [
  {
    "Description": "This link allows direct data 
access via Earthdata login",
    "URLContentType": "DistributionURL",
    "Type": "GET DATA",
    "URL": "https://daac.ornl.gov/daacdata/actamerica
/ACTAMERICA-PICARRO_Ground"
  }, {
    "Description": "Access the dataset landing page 
for the collection.",
    "URLContentType": "CollectionURL",
    "Type": "dataset LANDING PAGE",
    "URL":  "https://doi.org/10.3334/ORNLDAAC/1568",
  }, {
    "Description": "The guide document contains 
detailed information about the dataset.",
    "URLContentType": "PublicationURL",
    "Type": "VIEW RELATED INFORMATION",
    "Subtype": "USER'S GUIDE",
    "URL":  "https://daac.ornl.gov/ACTAMERICA/guides
/ACTAMERICA-PICARRO_Ground.html"
  }, {
    "Description": "Browse Image",
    "URLContentType": "VisualizationURL",
    "Type": "GET RELATED VISUALIZATION",
    "URL":  "https://daac.ornl.gov/graphics/browse
/project/act-america_logo.png"
  }, {
    "URLContentType" : "VisualizationURL",
    "Type" : "GET RELATED VISUALIZATION",
    "URL" : "https://s3.amazonaws.com/grfn-static
/SENTINEL-
1_INSAR_UNWRAPPED_INTERFEROGRAM_AND_COHERENCE_MAP_bro
wse.png"
  } 
]

ISO 19115-2 MENDS

An unlimited amount of Related URLs may be listed (Cardinality: 0..*)

Note: These ISO paths only apply to CollectionURLs and PublicationURLs. Please see the  for ISO RelatedURLs (GET DATA) wiki page
guidance specific to data access URLs. Please see the  for ISO guidance specific to services. RelatedURLs (USE SERVICE API) wiki page
Please see the Data Center wiki page for ISO guidance specific to DataCenterURLs. Please see the Data Contact wiki page for ISO guidance 
specific to DataCenterURLs.

UMM-C 
Element

ISO 19115-2 MENDS Path Type Notes

RelatedUrl
s/URL

/gmi:MI_Metadata/gmd:identificationInfo/gmd:
MD_DataIdentification/gmd:aggregationInfo/gmd:
MD_AggregateInformation/gmd:aggregateDataSetName/ gmd:
CI_Citation/gmd:citedResponsibleParty/gmd:CI_ResponsibleParty
/gmd:contactInfo/gmd:onlineResource/gmd:CI_OnlineResource
/gmd:linkage/gmd:URL

String Where the URL is provided.

Maps to the UMM element "RelatedUrls/URL"

Note: This path only applies to CollectionURLs and PublicationURLs.

RelatedUrl
s
/Description

/gmi:MI_Metadata/gmd:identificationInfo/gmd:
MD_DataIdentification/ gmd:aggregationInfo/gmd:
MD_AggregateInformation/gmd:aggregateDataSetName/ gmd:
CI_Citation/gmd:citedResponsibleParty/gmd:
CI_ResponsibleParty/ gmd:contactInfo/gmd:onlineResource/gmd:
CI_OnlineResource/gmd:description/gco:CharacterString="
Description: "

String Maps to the UMM element "RelatedUrls/Description"

A It brief, unique description of the URL should be provided in this field. 
is highly recommended that a description be provided for each URL.

* The character string should always start with the prefix "Description: " 
in order for CMR to properly parse out the URL description.

https://wiki.earthdata.nasa.gov/pages/viewpage.action?pageId=112497279
https://wiki.earthdata.nasa.gov/pages/viewpage.action?pageId=115935272


RelatedUrl
s
/URLConte
ntType

/gmi:MI_Metadata/gmd:identificationInfo/gmd:
MD_DataIdentification/ gmd:aggregationInfo/gmd:
MD_AggregateInformation/gmd:aggregateDataSetName/ gmd:
CI_Citation/gmd:citedResponsibleParty/gmd:
CI_ResponsibleParty/ gmd:contactInfo/gmd:onlineResource/gmd:
CI_OnlineResource/gmd:description/gco:CharacterString="
URLContentType: "

String Maps to the UMM element "RelatedUrls/URLContentType"

The URL Content Type is required in UMM and is used to specify how 
the link will display in the Earthdata Search Client. The URL Content 
Type must be selected from the following controlled vocabulary 
options: CollectionURL, PublicationURL, DataCenterURL, 
DistributionURL, DataContactURL, VisualizationURL. Please see the 
best practices section (above) on guidance on choosing the correct 
URL Content Type.

* The character string should always start with the prefix 
"URLContentType: " in order for CMR to properly parse out the URL 
Content Type.

RelatedUrl
s/Type

/gmi:MI_Metadata/gmd:identificationInfo/gmd:
MD_DataIdentification/ gmd:aggregationInfo/gmd:
MD_AggregateInformation/gmd:aggregateDataSetName/ gmd:
CI_Citation/gmd:citedResponsibleParty/gmd:
CI_ResponsibleParty/ gmd:contactInfo/gmd:onlineResource/gmd:
CI_OnlineResource/gmd:description/gco:CharacterString="Type: "

String Maps to the UMM element "RelatedUrls/Type"

Providing a URL Type is required in UMM. Failing to specify a Type in 
ISO metadata will result in the field being auto-populated by the CMR, 
which could result in the URL being mislabeled. URL Type is a GCMD 
controlled vocabulary field and must be selected from keywords in the K
MS. Please see the best practices section (above) on guidance on 
choosing the correct URL Type.

* The character string should always start with the prefix "Type: " in 
order for CMR to properly parse out the URL Type.

RelatedUrl
s/Subtype

/gmi:MI_Metadata/gmd:identificationInfo/gmd:
MD_DataIdentification/gmd:aggregationInfo/ gmd:
MD_AggregateInformation/gmd:aggregateDataSetName/ gmd:
CI_Citation/gmd:citedResponsibleParty/gmd:
CI_ResponsibleParty/ gmd:contactInfo/gmd:onlineResource/gmd:
CI_OnlineResource/gmd:description/gco:CharacterString="
Subtype: "

String Maps to the UMM element "RelatedUrls/Subtype"

Providing a URL Subtype is optional, but is encouraged if an 
appropriate URL Subtype exists. URL Subtype is a GCMD controlled 
vocabulary field and must be selected from keywords in the KMS. 
Please see the best practices section (above) on guidance on 
choosing the correct URL Subtype.

* The character string should always start with with the prefix "Subtype: 
" in order for CMR to properly parse out the URL Subtype.

Example Mapping

ISO 19115-2 MENDS

https://gcmd.earthdata.nasa.gov/kms/concepts/concept_scheme/rucontenttype?format=csv
https://gcmd.earthdata.nasa.gov/kms/concepts/concept_scheme/rucontenttype?format=csv
https://gcmd.earthdata.nasa.gov/kms/concepts/concept_scheme/rucontenttype?format=csv


<gmi:MI_Metadata>
...
  <gmd:identificationInfo>
  <gmd:MD_DataIdentification>
   <gmd:citation gco:nilReason="missing"/>
   <gmd:abstract gco:nilReason="missing"/>
    <gmd:aggregationInfo>
    <gmd:MD_AggregateInformation>
      <gmd:aggregateDataSetName>
        <gmd:CI_Citation>
        <gmd:title gco:nilReason="missing"/>
        <gmd:date gco:nilReason="missing"/>
          <gmd:citedResponsibleParty>
          <gmd:CI_ResponsibleParty>
            <gmd:contactInfo>
            <gmd:CI_Contact>
              <gmd:onlineResource>
              <gmd:CI_OnlineResource>
                <gmd:linkage>
                  <gmd:URL>https://doi.org/10.3334
/ORNLDAAC/1568</gmd:URL>
                </gmd:linkage>
                <gmd:description>
                  <gco:CharacterString>Description: 
Access the dataset landing page for the collection. 
URLContentType: CollectionURL URLType: dataset 
LANDING PAGE</gco:CharacterString>
                </gmd:description>
              </gmd:CI_OnlineResource>
              </gmd:onlineResource>
            </gmd:CI_Contact>
            </gmd:contactInfo>
           <gmd:role gco:nilReason="missing"/>
          </gmd:CI_ResponsibleParty>
          </gmd:citedResponsibleParty>
          <gmd:citedResponsibleParty>
          <gmd:CI_ResponsibleParty>
            <gmd:contactInfo>
             <gmd:CI_Contact>
              <gmd:onlineResource>
              <gmd:CI_OnlineResource>
                <gmd:linkage>
                  <gmd:URL>https://daac.ornl.gov
/ACTAMERICA/guides/ACTAMERICA-PICARRO_Ground.html<
/gmd:URL>
                </gmd:linkage>
                <gmd:description>
                  <gco:CharacterString>Description: 
The guide document contains detailed information 
about the dataset. URLContentType: PublicationURL 
URLType: VIEW RELATED INFORMATION URLSubtype: USER'S 
GUIDE</gco:CharacterString>
                </gmd:description>
              </gmd:CI_OnlineResource>
              </gmd:onlineResource>
             </gmd:CI_Contact>
            </gmd:contactInfo>
           <gmd:role gco:nilReason="missing"/>
          </gmd:CI_ResponsibleParty>
          </gmd:citedResponsibleParty>
        </gmd:CI_Citation>
      </gmd:aggregateDataSetName>
     <gmd:associationType gco:nilReason="missing"/>
    </gmd:MD_AggregateInformation>
    </gmd:aggregationInfo>
  </gmd:MD_DataIdentification>
  </gmd:identificationInfo>
...
</gmi:MI_Metadata>       



UMM

"RelatedUrls": [
  {
    "Description": "Access the dataset landing page 
for the collection.",
    "URLContentType": "CollectionURL",
    "Type": "dataset LANDING PAGE",
    "URL":  "https://doi.org/10.3334/ORNLDAAC/1568",
  }, {
    "Description": "The guide document contains 
detailed information about the dataset.",
    "URLContentType": "PublicationURL",
    "Type": "VIEW RELATED INFORMATION",
    "Subtype": "USER'S GUIDE",
    "URL":  "https://daac.ornl.gov/ACTAMERICA/guides
/ACTAMERICA-PICARRO_Ground.html"
  }
]

ISO 19115-2 SMAP

An unlimited amount of Related URLs may be listed (Cardinality: 0..*)

Note: These ISO paths only apply to CollectionURLs and PublicationURLs. Please see the  for ISO RelatedURLs (GET DATA) wiki page
guidance specific to data access URLs. Please see the  for ISO guidance specific to services. RelatedURLs (USE SERVICE API) wiki page
Please see the Data Center wiki page for ISO guidance specific to DataCenterURLs. Please see the Data Contact wiki page for ISO guidance 
specific to DataCenterURLs.

UMM-C 
Element

ISO 19115-2 SMAP Path Type Notes

RelatedUrl
s/URL

gmd:DS_Series/gmd:seriesMetadata/gmi:MI_Metadata/gmd:
identificationInfo/gmd:MD_DataIdentification/ gmd:aggregationInfo
/gmd:MD_AggregateInformation/gmd:aggregateDataSetName/ gmd:
CI_Citation/gmd:citedResponsibleParty/gmd:CI_ResponsibleParty/ 
gmd:contactInfo/gmd:onlineResource/gmd:CI_OnlineResource/gmd:
linkage/gmd:URL

String Where the URL is provided.

Maps to the UMM element "RelatedUrls/URL"

Note: This path only applies to CollectionURLs and 
PublicationURLs.

RelatedUrl
s
/Description

gmd:DS_Series/gmd:seriesMetadata/gmi:MI_Metadata/gmd:
identificationInfo/gmd:MD_DataIdentification/ gmd:aggregationInfo
/gmd:MD_AggregateInformation/gmd:aggregateDataSetName/ gmd:
CI_Citation/gmd:citedResponsibleParty/gmd:CI_ResponsibleParty/ 
gmd:contactInfo/gmd:onlineResource/gmd:CI_OnlineResource/gmd:
description/gco:CharacterString="Description:"

String Maps to the UMM element "RelatedUrls/Description"

It is highly recommended that a description be provided for each 
URL.

Provide a brief, unique description of the URL in this field. The 
value must start with the string "Description: " in order for CMR to 
properly identify the URL description.

RelatedUrl
s
/URLConte
ntType

gmd:DS_Series/gmd:seriesMetadata/gmi:MI_Metadata/gmd:
identificationInfo/gmd:MD_DataIdentification/ gmd:aggregationInfo
/gmd:MD_AggregateInformation/gmd:aggregateDataSetName/ gmd:
CI_Citation/gmd:citedResponsibleParty/gmd:CI_ResponsibleParty/ 
gmd:contactInfo/gmd:onlineResource/gmd:CI_OnlineResource/gmd:
description/gco:CharacterString="URLContentType:"

String Maps to the UMM element "RelatedUrls/URLContentType"

The value must start with the string "  " in order URLContentType:
for CMR to properly identify the URL Content Type.

The URL Content Type is required in UMM and is used to specify 
how the link will display in the Earthdata Search Client. The URL 
Content Type must be selected from the following controlled 
vocabulary options: CollectionURL, PublicationURL, 
DataCenterURL, DistributionURL, DataContactURL, 
VisualizationURL. Please see the best practices section (above) on 
guidance on choosing the correct URL Content Type.

RelatedUrl
s/Type

gmd:DS_Series/gmd:seriesMetadata/gmi:MI_Metadata/gmd:
identificationInfo/gmd:MD_DataIdentification/ gmd:aggregationInfo
/gmd:MD_AggregateInformation/gmd:aggregateDataSetName/ gmd:
CI_Citation/gmd:citedResponsibleParty/gmd:CI_ResponsibleParty/ 
gmd:contactInfo/gmd:onlineResource/gmd:CI_OnlineResource/gmd:
description/gco:CharacterString="Type:" 

String Maps to the UMM element "RelatedUrls/Type."

The value must start with the string "Type: " in order for CMR to 
properly identify the URL Type.

Providing a URL Type is required in UMM. Failing to specify a Type 
in ISO metadata will result in the field being auto-populated by the 
CMR, which could result in the URL being mislabeled. URL Type is 
a GCMD controlled vocabulary field and must be selected from 
keywords in the . Please see the best practices section KMS
(above) on guidance on choosing the correct URL Type.

https://wiki.earthdata.nasa.gov/pages/viewpage.action?pageId=112497279
https://wiki.earthdata.nasa.gov/pages/viewpage.action?pageId=115935272
https://gcmd.earthdata.nasa.gov/kms/concepts/concept_scheme/rucontenttype?format=csv


RelatedUrl
s/Subtype

gmd:DS_Series/gmd:seriesMetadata/gmi:MI_Metadata/gmd:
identificationInfo/gmd:MD_DataIdentification/ gmd:aggregationInfo
/gmd:MD_AggregateInformation/gmd:aggregateDataSetName/ gmd:
CI_Citation/gmd:citedResponsibleParty/gmd:CI_ResponsibleParty/ 
gmd:contactInfo/gmd:onlineResource/gmd:CI_OnlineResource/gmd:
description/gco:CharacterString="Subtype:

String Maps to the UMM element "RelatedUrls/Subtype"

The value must start with the string "Subtype: " in order for CMR to 
properly identify the URL Subtype.

Providing a URL Subtype is optional, but is encouraged if an 
appropriate URL Subtype exists. URL Subtype is a GCMD 
controlled vocabulary field and must be selected from keywords in 
the . Please see the best practices section (above) on KMS
guidance on choosing the correct URL Subtype.

Example Mapping

ISO 19115-2 SMAP

<gmd:DS_Series>
<gmd:seriesMetadata>
<gmi:MI_Metadata>
...
  <gmd:identificationInfo>
  <gmd:MD_DataIdentification>
   <gmd:citation gco:nilReason="missing"/>
   <gmd:abstract gco:nilReason="missing"/>
    <gmd:aggregationInfo>
    <gmd:MD_AggregateInformation>
      <gmd:aggregateDataSetName>
        <gmd:CI_Citation>
        <gmd:title gco:nilReason="missing"/>
        <gmd:date gco:nilReason="missing"/>
          <gmd:citedResponsibleParty>
          <gmd:CI_ResponsibleParty>
            <gmd:contactInfo>
            <gmd:CI_Contact>
              <gmd:onlineResource>
              <gmd:CI_OnlineResource>
                <gmd:linkage>
                  <gmd:URL>https://doi.org/10.3334
/ORNLDAAC/1568</gmd:URL>
                </gmd:linkage>
                <gmd:description>
                  <gco:CharacterString>Description: 
Access the dataset landing page for the collection. 
URLContentType: CollectionURL URLType: dataset 
LANDING PAGE</gco:CharacterString>
                </gmd:description>
              </gmd:CI_OnlineResource>
              </gmd:onlineResource>
            </gmd:CI_Contact>
            </gmd:contactInfo>
           <gmd:role gco:nilReason="missing"/>
          </gmd:CI_ResponsibleParty>
          </gmd:citedResponsibleParty>
          <gmd:citedResponsibleParty>
          <gmd:CI_ResponsibleParty>
            <gmd:contactInfo>
             <gmd:CI_Contact>
              <gmd:onlineResource>
              <gmd:CI_OnlineResource>
                <gmd:linkage>
                  <gmd:URL>https://daac.ornl.gov
/ACTAMERICA/guides/ACTAMERICA-PICARRO_Ground.html<
/gmd:URL>
                </gmd:linkage>
                <gmd:description>
                  <gco:CharacterString>Description: 
The guide document contains detailed information 
about the dataset. URLContentType: PublicationURL 
URLType: VIEW RELATED INFORMATION URLSubtype: USER'S 
GUIDE</gco:CharacterString>
                </gmd:description>
              </gmd:CI_OnlineResource>

https://gcmd.earthdata.nasa.gov/kms/concepts/concept_scheme/rucontenttype?format=csv


              </gmd:onlineResource>
             </gmd:CI_Contact>
            </gmd:contactInfo>
           <gmd:role gco:nilReason="missing"/>
          </gmd:CI_ResponsibleParty>
          </gmd:citedResponsibleParty>
        </gmd:CI_Citation>
      </gmd:aggregateDataSetName>
     <gmd:associationType gco:nilReason="missing"/>
    </gmd:MD_AggregateInformation>
    </gmd:aggregationInfo>
  </gmd:MD_DataIdentification>
  </gmd:identificationInfo>
...
</gmi:MI_Metadata> 
</gmd:seriesMetadata>  
</gmd:DS_Series>    

UMM

"RelatedUrls": [
  {
    "Description": "Access the dataset landing page 
for the collection.",
    "URLContentType": "CollectionURL",
    "Type": "dataset LANDING PAGE",
    "URL":  "https://doi.org/10.3334/ORNLDAAC/1568",
  }, {
    "Description": "The guide document contains 
detailed information about the dataset.",
    "URLContentType": "PublicationURL",
    "Type": "VIEW RELATED INFORMATION",
    "Subtype": "USER'S GUIDE",
    "URL":  "https://daac.ornl.gov/ACTAMERICA/guides
/ACTAMERICA-PICARRO_Ground.html"
  }
]

UMM Migration

None

History

UMM Versioning

Version Date What Changed

1.17.1 8/10
/2022

No changes were made for RelatedUrls during the transition from version 1.17 to 1.17.1

1.17 5/11
/2022

No changes were made for RelatedUrls during the transition from version 1.16.7 to 1.17

1.16.7 3/2
/2022

No changes were made for RelatedUrls during the transition from version 1.16.6 to 1.16.7

1.16.6 12/1
/2021

No changes were made for RelatedUrls during the transition from version 1.16.5 to 1.16.6

1.16.5 7/13
/2021

Removed enumerations for RelatedUrls/URLContentType, RelatedUrls/Type, and RelatedUrls/Subtype values, and 
indicating that  should be the source of the values.KMS

https://gcmd.earthdata.nasa.gov/kms/concepts/concept_scheme/rucontenttype?format=csv


1.16.4 6/30
/2021

Changed RelatedUrls that adds HITIDE, SOTO, Sub-Orbital Order Tool, and CERES Ordering Tool as new  
enumerations to the subtype field.

1.16.3 5/19
/2021

Changed RelatedURL that adds GET CAPABILITIES as a new enumeration to the type field and adds GIBS as a new 
subtype, opensearch already exists as a valid subtype.

1.16.2 4/7
/2021

No changes were made for RelatedUrls during the transition from version 1.16.1 to 1.16.2

1.16.1 4/7
/2021

No changes were made for RelatedUrls during the transition from version 1.16.0 to 1.16.1

1.16.0 3/24
/2021

No changes were made for RelatedUrls during the transition from version 1.15.5 to 1.16.0

1.15.5 12/3
/2020

No changes were made for RelatedUrls during the transition from version 1.15.4 to 1.15.5

1.15.4 9/18
/2020

No changes were made for RelatedUrls during the transition from version 1.15.3 to 1.15.4

1.15.3 7/1
/2020

No changes were made for RelatedUrls during the transition from version 1.15.2 to 1.15.3

1.15.2 5/20
/2020

No changes were made for RelatedUrls during the transition from version 1.15.1 to 1.15.2

1.15.1 3/25
/2020

No changes were made for RelatedUrls during the transition from version 1.15.0 to 1.15.1

1.15.0 2/26
/2020

No changes were made for RelatedUrls during the transition from version 1.14.0 to 1.15.0

1.14.0 10/21
/2019

No changes were made for RelatedUrls during the transition from version 1.13.0 to 1.14.0

1.13.0 04/11
/2019

No changes were made for RelatedUrls during the transition from version 1.12.0 to 1.13.0.

1.12.0 01/22
/2019

During the transition from version 1.11.0 to 1.12.0, 4 new Related URL keywords were added.

1.11.0 11/28
/2018

During the transition from version 1.10.0 to 1.11.0, the enumerations for sub elements 'Type' and 'Subtype' were changed to 
match the GCMD version of the keywords that was released on March 15, 2018.

1.10.0 05/02
/2018

During the transition from version 1.9.0 to 1.10.0, the following sub elements were added: 'Mime Type' (Get Data) and 
'Format' (Get Service).

ARC Documentation

Version Date What Changed Author

1.0 07/25/2018 Recommendations/priority matrix transferred from internal ARC documentation to wiki space Jeanne' le Roux

https://wiki.earthdata.nasa.gov/display/~jr0020
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